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1. Remote Web Manager



1.1.Remote Web Manager

Remote Web Manager is a utility to monitor the operation, managing, organization and configuration of

Print Server. It is possible to operate all the functions related to Print Server.

1.1.1. System Configuration
Following Hardware or System Configuration is necessary in order to use Remote Web Manager
comfortably.

(1) Hardware and System, which are conforming to the system requirement of Internet Explorer

6.0 SP1.

(2) Install Java software.

Download and install Java software (Free Download).

It is available at SUN Microsystems web site. (http://java.com/en/download/)

Remote Web Manager screen is not indicated correctly if Java Software is not installed.

(3) Resolution of Display should be 1024 x 768 dots or more.
1.1.2. Log-on to Remote Web Manager

Remote Web Manager allows browsing only for the registered user on Print Server. Therefore,
when it is connected at the first time through browser of remote client, log-on dialog is always
indicated to confirm the user.

Web Manager Login

TserM ame :

FPassword :



2. Client Preparation



2.1.Movement Confirmation

2.1.1. Connection to Remote Web Manager

Connect to Remote Web Manager using Web browser.

(Our configuration is shown below as an example.

(1) Start up [Internet Explorer].

e

Imternet
Explorer

Address is just the example.)

Make Internet temporary file setting to the browser.

Click [Tools] — [Internet Options].

/3 Cannot find server - Microsoft Internet Explorer

J File Edt ‘fiew Favoites | Tooks  Help

i 3
- ) = ) @ tail and Mews

Bark Eariwand Stop Synichrarize...

|
Q &=

parch  Favortes

Windows Update
J Address @ hittp: /Ay microzofl

Show Related Links

vx] @Go | |Links

s

Internet Options. ..

4]

Enablez you to change zettings.

Click [Settings] on “General” tab.

Select [Every visit to the page], and then click [OK].



Sotngs ———— EE|

‘ Check for newer versions of stored pages:
G ’ ]
&y n! izi Qe

™ Ewery time you start Intemet E xplorer

= Automatically
™ Mever

— Temporary Internet files folder

Current location:G: I M T 40ESProfiles Administrators T ermparar,
|rternet Files'

Amount of disk zpace to use:

j | 0= ME

Mowve Folder... | Wiew Filez... | Wiew Objects. .. |

(] I Cancel |

Click [OK] on [Internet Option], and then close this.

Input [http://Server Name or Server IP Address] to the address.

(2) When User confirmation image is indicated at the first access from browser, put the
following User Name and the Password of shipping.

Default State:
User Name administrator

Password  (blank)
Click [Login].

Web Manager Login

TserM ame :

FPassword :



If it is connected properly, the following Page is indicated.

Remote Web Manager

ﬂ Device TWehCIientT Filter T Option Y Log T User Y SystemT Scan 1

Document : Status Owner Printer Request Size Submit Time

Device : Printer ready

Cancel Sleep Mode Refresh

_ 0.2% Used Feb 19, 2006 2:14 PM

This page is the main (Home) page of Remote Web Manager. Register this page to [favorite]

of Internet Explorer. Direct access to this main page becomes available.

If above shown operation is done without problem, preparation of Remote Web Manager is

done.

For the further detail, refer to [Operation method of Remote Web Manager].



3. Operation
of
Remote Web Manager



Remote Web Manager is a Ultility in order to operate, manage, create configuration and
observe background of Print Server. It is possible to operate anything that is related to
Print Server.

To use Remote Web Manager, usable functions differ by logging on as the administrator
or logging on as an added user.

The administrator can use all the functions of Remote Web Manager.



3.1.Function

3.1.1. Spooler

Remote Web Manager

ﬂ Device YWehCIientY Filter Y Option Y Log Y User Y SystemY Scan 1

Document : Status Owner Printer Reqguest Size Submit Time

Etror

Device : Printer ready

Cancel Sleep Mode Refresh

_ 02% Used Feh 19, 2006 314 PM

Observe the situation of Printing job and control it in this Main configuration.

The administrator can operate such as reprinting or erasing against the entire job.

In case of ordinal user, operation against own job is possible.
¢ Printed queue
This is the list what was printed.
If it is double clicked, detail information of this job is known.
¢ Wait queue
This is the job list that is waiting for print.
¢ Pause queue
This is the job list, which is temporary held to print.

e Error queue

This is the job list what error occurred. If it is double clicked, it is possible to know the

detail of the error.
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3.1.2. Device
When Device Button is clicked, the Status of the device is indicated.
T - 4800w |
|
] |
|
|

Roll 1 [Plain |Iget |34t mm
Rall 2 [Plain |Iget ||297mm

[ I [
| [

Paper Size

It is possible to observe the status of Printer with this dialog.

Roll 1
Paper information in the front of paper deck is indicated.

Roll 2
Paper information in the rear of paper deck is indicated.
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3.1.3. Web Client

Web Client can output the print job that consists of multiple image files.
Follow the instruction below.
1) Click “Select File (Step 1)”. Click a plot file (files) on the left column and click “Select” button. A

specified file (files) is added to Job list on the right column.

| | Output Joh(Step 2) |
[c:PiotData'CEBITOEPLT_FIN [+] Job
o [CIMEQCache = Mo Mame In Directry Evtes
9 [ PlotData 1 A0_1_ASE.PLT  |CAPIotData\CEB... 167752
L Jesl) AR AT CPeDamcEE. 185673
o [ CADDATA | | ER otData
o I PLT_FIN
o~ PLT_LOMNG L
- I TIFF
o 3 FrintClient
o= [ Program Files |
o I RECYCLER
o= [ System Yolume Infarmation =1
MNarme Bytes
.DS_Stare 16364 |~
AD_1_ASEPLT 167752 _ *
AD_7_FILPLT 178248] |
0_3 _HWAPLT 183073
AD_4_GASPLT 330677 Select
A0_S_EL1.PLT 10B8164
A0_B_ELZPLT 98944 Select Al
AD_7_ADEPLT 137846
AD_B_ADFPLT 140633 Cancel
AD_6_ADEFLT 377aTA
A1 _1_ASEPLT T54240]_ | peete || peetean | [a] [v]
&1 7 FIL PIT 1RAAZZLT

Supported file types are HPGL, Calcomp, TIFF, CALS, BMP and PDF (option).

2) Click “Output Job (Step 2)” tab. Refer to the next page for Job Setup Settings.

| Select File(Step 1) H

Job Name : lso_1_asEPLT |
Job Setup
MO Mame l/ General r HPGL rCaIcomp r0riginal Size Compensation |
1 |AO_1_ASEPLT|| yob Count: Print Setting
7 |[A0_2_FILPLT i .
T rkeLT| Output Size ; Original [~ Scale
XY Separate
Collate Number Of Copies : 1 E L%y Sep
thye X ¥ I
Densty: Meia Type :
[
Rotation : [] Enable Margin Setting
[_] Header
Tray Selection:
” =] o =L
. Standard Cut
Output Queue : i Trailing Edge : El mm

] Mirror

|| Negative Image

| Image Placement |

i 5 .

3) When “Print” button is clicked, output starts.
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Setting Items

[General]
l/GeneraI r HPGL r Calcomp r Original Size Compensation |
Job Count : Print Setting
I:EI Output Size : |0riginal | - | Scale
XY Separate
Collate Number OF Copies : 1 El O &
e ¥: . U
LELHE- Media Type : [Prain |~]
[ e
Rotation : [Ruto |w|  [1Enable Margin Setting
[ Header
q Tray Selection : Auto -
| Setting | i | | | Leading Edge : E mm
. Standard Cut
0“?““‘ Queue: d Trailing Edge : E mm
|Pr|nt | h | [] Mirror
| Image Placement |
[] Megative Image
Default

<Job Count>

Sets the job count

<Collate>
Check Collate ON
No check  Collate OFF
<Density>

Set Image Density
When input value is smaller, it shows lighter image, and vice versa.
1-9
<Header>
When Header output is set to effective, following information is printed out at the
leading or trailing edge of output.
Printed information:
Requester, Job Number, File Name, Date/Time

When button is clicked, following dialog is popped up.

13



Placement : |LEﬂﬂi“Q Left | v |

Text Size : IIE

Requester : | |

Joh Humber : | |
OK Cancel

<Output Queue>
Select print job is sent to “Print queue” or “Pause queue”.
<Output Size>
Usually select original
Original
Scale
(The following size are indicated when “Metric” is selected on Paper Unit of
Option Settings)
A0, A1, A2, A3, A4, 24x36, 36x48
(The following size are indicated when “Inch” is selected on Paper Unit of
Option Settings)
ANSI-A, ANSI-B, ANSI-C, ANSI-D, ANSI-E, ARCH-A, ARCH-B, ARCH-C,
ARCH-D, ARCH-E, 30 x 42
<Number of Copies>
Setting of number of print
1-999
<Media Type>
Select paper material
Plain
Vellum
Film
Any

14



<Rotation>
Select output direction
Auto
0
90
180
270
<Tray Selection>
Select paper deck
Auto
Deck 1
Deck 2
Bypass
<Cut Mode>
Select cut mode of paper
Check Standard Cut
No check Synchronized Cut
<Mirror>
Setting of mirror
<Negative Image>
A mirror image can be printed
<Scale>
Configures the magnification setting
When specified X-direction and Y-direction separately, check “X, Y Separate”.
<Margin>
Add a preferable margin to the leading edge and the trailing edge of output print.
Leading Edge 0 to 500mm
Trailing Edge 0 to 500mm
<Image Shift>
Set if Image is required to shift from the center.

When “Set” button is clicked, the following dialog is popped up.

15



Image Shift X
X +
+
h
Offset
x| D}ZI' mm ¥: | D}ZI' mm
| OK | | Cancel |

Image placement is selectable up-shown 9 locations.
When fine adjustment of the location is necessary, enter the value to move to
Offset X and Y.
When X is set as a positive, it moves to right. (-500 to 500)
When X is set as a negative, it moves to left. (-500 to 500)
When Y is set as a positive, it moves to upper. (-500 to 500)

When Y is set as a negative, it moves to lower. (-500 to 500)

16



[HPGL]
Job Settings HPGL r Calcomp r 0Original Size Compensation

Pen Width Mode : ® Values in file ) User defined values RTL Raster Density : 1 DDE
Grayscale Mode : ® Values in file ) User defined values Enable Clippng
Pen M nt
en ifanageme [ | Enable Pen Scale
Manage Pens | READ ‘ | SAVE | [] Cut and feed by SP/SPO
Pen Mo, Pen Size Grayscale
1 0.35mm 100% =
2 0.35mm 100% |=|
3 0.35mm 100%
4 0.35mm 100%
5 0.35mm 100%
£ 0.35mm 100%
7 0.35mm 100%
3 0.35mm 100%
q 0.35mm 100% -

<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
¢ Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<RTL Raster Density>
Adjust the density of HPGL RTL Image.
However, it is effective only if RTL image data are multi-valued image.
<Enable Clipping>
When this is checked, the value of HPGL PS command is taken as the size of
image.
When this is not checked, image size is taken from minimum to maximum of
image.

17



<Enable Pen Scale>
The pen width is also enlarged or reduced if output size is enlarged or reduced.
If you do not check it, the pen width is same even if output size is enlarged or
reduced.

<Cut and feed by SP/SP0>
Multi-files are outputted since SP/SP0 command is recognized as a boundary of

multi-drawing if it is included in the file.

18



[Calcomp]

r Job Settings r HPGL |TCaIcump r Original Size Compensation

Pen Width Mode : @ Values in file ) User defined values Synchronization Setting
Grayscale Mode : @ Values in file ) User defined values Auto Detection

Pen Management

Manage Pens ‘ READ | ‘ SAVE |
Fen Mo, Fen Size Grayscale

1 0.35mm 100% -
2 0.35mm 100% =]
3 0.35mm 100%
4 0.35mm 100%
a 0.35mm 100%
53 0.35mm 100%
7 0.35mm 100%
B 0.35mm 100% Step: 800 [stepsicm
9 0.35mm 100% -

<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<Synchronization Setting>
A preferable Synchronization can be specified by either Automatic Setting or
Manual Setting.
Check “Auto Detection” in normal use. You can manually configure “Double Sync”,
“Checksum?”, “Sync-Cha” and “End-Char”.
<Step Setting>
The output size of image can be changed by setting of a step number. Usually, set
to 800 for Step Setting.

19



[Original Size Compensation]

(General r HPGL rCaIcomp |/0riginal Size Compensation |

Enable Original Size Compensation

Plain
Length 1005 Yo Width 1005 k)

Yellum

Length 1005 % Width 1005 U
Film

Length 1 DDE % Width 1 DDE U

It is possible to specify the magnification of x-direction and y-direction

independently for each media.

The print size can be compensated caused by media expansion and contraction by
this.

When “Enable Original Size Compensation” is checked, the magnification
compensation is effective for each media (Plain/Vellum/Film).

Itis possible for each media to compensate the magnification of x-direction (Width) and
y-direction (Length) independently.

The compensation ranges are guaranteed between 90% and 110%. (0.01% step)

20



3.1.4. Filter

3.1.41 FTP

e Output method

The method to use ftp, and output.
Ex.

ftp “IP Address”

(Logon to ftp User Name: auto, Password: print)

bin
cd ftp01

put “File name”

Supported file types are HPGL, Calcomp, TIFF, CALS, BMP and PDF (option).

o Setting Items

[General]
| I LPR Filter |
Filter : Spool Directory : ftp01
FTP1 [rGeneraI r HPGL rCaIcomp rOriginaI Size Compensation |
FTP2 . .
FTP3 Print Setting
i Original : scale
Oupusze:  [oigna |
. b [ %.¥ Separate
Humber Of Copies : 1 E
FTPG LS L H L
FTP7 Media Type :
FTPE Enable Margin Settin
Rotation = .
FTP9
FTP10 Tray Selection : Leading Edge : E mm
FTP11
Standard Cut Trailing Edge : mm
FTP12 = g E
Mirror
::E:i U Density : BE
[] Hegative Image
FTP15 Image Placement |
FTP16

21



<Output Size>
Usually select original
Original
Scale
(The following size are indicated when “Metric” is selected on Paper Unit of
Option Settings)
A0, A1, A2, A3, A4, 24x36, 36x48
(The following size are indicated when “Inch” is selected on Paper Unit of
Option Settings)
ANSI-A, ANSI-B, ANSI-C, ANSI-D, ANSI-E, ARCH-A, ARCH-B, ARCH-C,
ARCH-D, ARCH-E, 30 x 42
<Number of Copies>
Setting of number of print
1-999
<Media Type>
Select paper material
Plain
Vellum
Film
Any
<Rotation>
Select output direction
Auto
0
90
180
270
<Tray Selection>
Select paper deck
Auto
Deck 1
Deck 2
Bypass
<Scale>
Configures the magnification setting

When specified X-direction and Y-direction separately, check “X, Y Separate”.
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<Cut Mode>

Select cut mode of paper

Check Standard Cut
No check Synchronized Cut
<Mirror>

Setting of mirror
<Negative Image>
A mirror image can be printed
<Margin>
Add a preferable margin to the leading edge and the trailing edge of output print.
Leading Edge 0 to 500mm
Trailing Edge 0 to 500mm
<Density>
Set Image Density
When input value is smaller, it shows lighter image, and vice versa.
1-9
<Image Shift>
Set if Image is required to shift from the center.

When “Set” button is clicked, the following dialog is popped up.

Image Shift X
X +
+
h
Offset
x| D}ZI' mm ¥: | D}ZI' mm
| OK | | Cancel |
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Image placement is selectable up-shown 9 locations.
When fine adjustment of the location is necessary, enter the value to move to
Offset X and Y.
When X is set as a positive, it moves to right. (-500 to 500)
When X is set as a negative, it moves to left. (-500 to 500)
When Y is set as a positive, it moves to upper. (-500 to 500)

When Y is set as a negative, it moves to lower. (-500 to 500)

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[HP-GL]

( General fr HPGL r Calcomp r Original Size Compensation

Pen Width Mode : ® Values in file ) User defined values RTL Raster Density : 1 DDE
Grayscale Mode : ® Values in file ) User defined values Enable Clippng
Pen M it
DS [ Enable Pen Scale
RManauEiEns | R | | SLAE | [] Cut and feed by SP/SPO
FPen Mo. Pen Size Grayscale
1 0.35mm 100% -~
2 0.35mm 100% |=|
3 0.35mm 100%
4 0.35mm 100%
5 0.35mm 100%
B 0.35mm 100%
T 0.35mm 100%
g 0.35mm 100%
9 0.35mm 100% ~

<Pen Width Mode>

<Grayscale Mode>

When “Values in file” is selected, the values of Pen Width and Grayscale specified

in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<RTL Raster Density>
Adjust the density of HPGL RTL Image.
However, it is effective only if RTL image data are multi-valued image.
<Enable Clipping>
When this is checked, the value of HPGL PS command is taken as the size of
image.
When this is not checked, image size is taken from minimum to maximum of

image.

25



<Enable Pen Scale>
If you check “Pen Scale”, the pen width is also enlarged or reduced if output size
is enlarged or reduced.
If you do not check it, the pen width is same even if output size is enlarged or
reduced.

<Cut and feed by SP/SP0>
When this is checked, multi-files are outputted since SP/SPO command is

recognized as a boundary of multi-drawing if it is included in the file.

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Calcomp]

r Job Settings r HPGL |TCaIcump r Original Size Compensation

Pen Width Mode : @ Values in file ) User defined values Synchronization Setting
Grayscale Mode : @ Values in file ) User defined values Auto Detection

Pen Management

Manage Pens ‘ READ | ‘ SAVE |
Fen Mo, Fen Size Grayscale

1 0.35mm 100% -
2 0.35mm 100% =]
3 0.35mm 100%
4 0.35mm 100%
a 0.35mm 100%
53 0.35mm 100%
7 0.35mm 100%
B 0.35mm 100% Step: 800 [stepsicm
9 0.35mm 100% -

<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<Synchronization Setting>
A preferable Synchronization can be specified by either Automatic Setting or
Manual Setting.
Check “Auto Detection” in normal use. You can manually configure “Double Sync”,
“Checksum?”, “Sync-Cha” and “End-Char”.
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<Step Setting>
The output size of image can be changed by setting of a step number. Usually, set
to 800 for Step Setting.

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Original Size Compensation]

( General r HPGL |/ Calcomp |/ Original Size Compensation

Enable Original Size Compensation
Plain

Length 1 DDE % Width 1 DDE U

Yellum

Length 1005 % Width 1005 U
Film

Length 1 DDE % Width 1 DDE U

It is possible to specify the magnification of x-direction and y-direction

independently for each media.

The print size can be compensated caused by media expansion and contraction by
this.

When “Enable Original Size Compensation” is checked, the magnification
compensation is effective for each media (Plain/Vellum/Film).

Itis possible for each media to compensate the magnification of x-direction (Width) and
y-direction (Length) independently.

The compensation ranges are guaranteed between 90% and 110%. (0.01% step)

Note: If some of the above items are modified, click [Enter] button, and
register the configuration.
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3.1.4.2 LPR
e  Setting of Lpr
Standard setting
Individual setting is possible to save for every 16 setting value entry.
Set all of the following directories, push [Enter] button and package register all the setting of

directories.

Use following Printer name corresponding to each setting value entry.

Entry Printer name
1 IprO1
2 Ipr02
3 IprO3
4 lprO4
5 Ipr05
6 lprO6
7 lpr07
8 lpr08
9 pr09
10 lpr10
11 Ipr11
12 lpr12
13 lpr13
14 lpr14
15 lpr15
16 lpr16

Example:

If you wish to output Entry 1 from Windows OS:
[lpr =S 192.168.100.10 —P Ipr01 —o | “output file name” ]

Supported file types are HPGL, Calcomp, TIFF, CALS, BMP and PDF (option).

30



Setting Items
[General]

FTP Filter |

Filter :

LPR1
LPR2
LPR3
LPR4
LPR5
LPRG
LPR?
LPRS
LPR9
LPR10
LPR11
LPR12
LPR13
LPR14
LPR15
LPR16

l/GeneraI r HPGL rCaIcomp rOriginaI Size Compensation |

Print Setting
Output size:

Humber Of Copies :

Scale

K
O

Media Type :

Enahle Margin Settin
Rotation : U d d

]

Tray Selection :
Standard Cut

Mirror
U Density : BE

[] Hegative Image
Image Placement |

<Output Size>
Usually select original
Original
Scale
(The following size are indicated when “Metric” is selected on Paper Unit of
Option Settings)
A0, A1, A2, A3, A4, 24x36, 36x48
(The following size are indicated when “Inch” is selected on Paper Unit of
Option Settings)
ANSI-A, ANSI-B, ANSI-C, ANSI-D, ANSI-E, ARCH-A, ARCH-B, ARCH-C,
ARCH-D, ARCH-E, 30 x 42
<Number of Copies>
Setting of number of print
1-999
<Media Type>
Select paper material
Plain
Vellum
Film
Any

31



<Rotation>
Select output direction
Auto
0
90
180
270
<Tray Selection>
Select paper deck
Auto
Deck 1
Deck 2
Bypass
<Cut Mode>
Select cut mode of paper
Check Standard Cut
No check Synchronized Cut
<Mirror>
Setting of mirror
<Negative Image>
A mirror image can be printed
<Scale>
Configures the magnification setting
When specified X-direction and Y-direction separately, check “X, Y Separate”.
<Margin>
Add a preferable margin to the leading edge and the trailing edge of output print.
Leading Edge 0 to 500mm
Trailing Edge 0 to 500mm
<Density>
Set Image Density
When input value is smaller, it shows lighter image, and vice versa.
1-9
<Image Shift>
Set if Image is required to shift from the center.

When “Set” button is clicked, the following dialog is popped up.
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Image Shift X
X +
+
h
Offset
x| D}ZI' mm ¥: | D}ZI' mm
| OK | | Cancel |

Image placement is selectable up-shown 9 locations.
When fine adjustment of the location is necessary, enter the value to move to
Offset X and Y.
When X is set as a positive, it moves to right. (-500 to 500)
When X is set as a negative, it moves to left. (-500 to 500)
When Y is set as a positive, it moves to upper. (-500 to 500)

When Y is set as a negative, it moves to lower. (-500 to 500)

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[HP-GL]

( General fr HPGL r Calcomp r Original Size Compensation

Pen Width Mode : ® Values in file ) User defined values RTL Raster Density : 1 DDE
Grayscale Mode : ® Values in file ) User defined values Enable Clippng
Pen M it
DS [ Enable Pen Scale
RManauEiEns | R | | SLAE | [] Cut and feed by SP/SPO
FPen Mo. Pen Size Grayscale
1 0.35mm 100% -~
2 0.35mm 100% |=|
3 0.35mm 100%
4 0.35mm 100%
5 0.35mm 100%
B 0.35mm 100%
T 0.35mm 100%
g 0.35mm 100%
9 0.35mm 100% ~

<Pen Width Mode>

<Grayscale Mode>

When “Values in file” is selected, the values of Pen Width and Grayscale specified

in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<RTL Raster Density>
Adjust the density of HPGL RTL Image.
However, it is effective only if RTL image data are multi-valued image.
<Enable Clipping>
When this is checked, the value of HPGL PS command is taken as the size of
image.
When this is not checked, image size is taken from minimum to maximum of

image.
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<Enable Pen Scale>
If you check “Pen Scale”, the pen width is also enlarged or reduced if output size
is enlarged or reduced.
If you do not check it, the pen width is same even if output size is enlarged or
reduced.

<Cut and feed by SP/SP0>
When this is checked, multi-files are outputted since SP/SPO command is

recognized as a boundary of multi-drawing if it is included in the file.

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Calcomp]

r Job Settings r HPGL |TCaIcump r Original Size Compensation

Pen Width Mode : @ Values in file ) User defined values Synchronization Setting
Grayscale Mode : @ Values in file ) User defined values Auto Detection

Pen Management

Manage Pens ‘ READ | ‘ SAVE |
Fen Mo, Fen Size Grayscale

1 0.35mm 100% -
2 0.35mm 100% =]
3 0.35mm 100%
4 0.35mm 100%
a 0.35mm 100%
53 0.35mm 100%
7 0.35mm 100%
B 0.35mm 100% Step: 800 [stepsicm
9 0.35mm 100% -

<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<Synchronization Setting>
A preferable Synchronization can be specified by either Automatic Setting or
Manual Setting.
Check “Auto Detection” in normal use. You can manually configure “Double Sync”,
“Checksum?”, “Sync-Cha” and “End-Char”.
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<Step Setting>
The output size of image can be changed by setting of a step number. Usually, set
to 800 for Step Setting.

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Original Size Compensation]

( General r HPGL |/ Calcomp |/ Original Size Compensation

Enable Original Size Compensation
Plain

Length 1 DDE % Width 1 DDE U

Yellum

Length 1005 % Width 1005 U
Film

Length 1 DDE % Width 1 DDE U

It is possible to specify the magnification of x-direction and y-direction

independently for each media.

The print size can be compensated caused by media expansion and contraction by
this.

When “Enable Original Size Compensation” is checked, the magnification
compensation is effective for each media (Plain/Vellum/Film).

Itis possible for each media to compensate the magnification of x-direction (Width) and
y-direction (Length) independently.

The compensation ranges are guaranteed between 90% and 110%. (0.01% step)

Note: If some of the above items are modified, click [Enter] button, and
register the configuration.
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3.1.5. Option

Option function of device is available by clicking Option Setting Button.

Only the administrator can change this setting.

[General]

General | HPGL | Calcomp | Original Size Compensation |

Printer : Print Setting
[kM-4800w [*] ' Number of Copies : 1H [] Enable Margin Setting
Paper Unit : Rotation :
|M9m° | e | Tray Selection :
S AiEe Standard Cut
I a——— — Densiy H
Tolerance : ] Negative Image | Image Placement |
’57 mm
Screening :

Frequency: EEE Ipi

Angle : 455 ®

[_] Resolution Conversion

<Printer>
Setting of printer model to use
<Paper Unit>
Setting of Metric(ISO) / Inch(ANSI) of paper size
<Output Mode>
Setting of Output Mode
Mode1: Case of output by printer driver
Print an image to the paper which is same in size.
image size = paper size
Case of output by Filter (FTP and LPR), Web Client,
Print Client KM
Print an image to the paper which is same or large.
1. image size = paper size
2. image size < paper size

(2. is not available for standard size output)

Mode2: Print an image to the paper which is same or large enough.

The Paper Priority in Selection:
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1. image size = paper size

2. image size < paper size

Mode3: Print an image, if any paper exists.
The Paper Priority in Selection:
1. image size = paper size
2. image size < paper size
3. image size > paper size
<Tolerance>
Even if output file size is larger than regular paper size, it is possible to output on
its regular size, up to the value of tolerance. When paper size is selected, even if
output file size is little bit larger than regular paper size, it is possible to output on
the paper or regular size by changing the value of tolerance due to the allowance
value is expanded”
<Screening>
Change print pattern of gray area. Adjust the gray area, which is described in grid,
by changing the number of lines and the angle. It is possible to change the pattern
of gray by changing the number of lines per inch (Ipi) and the angle of line”
<Resolution Conversion>
Non 600dpi image can be printed with high quality.
However it takes longer time than usual until printing is finished.
<Number of Copies>
Setting of number of print
1-999
<Rotation>
Select output direction
Auto
0
90
180
270
<Tray Selection>
Select paper deck
Auto
Deck 1
Deck 2
Bypass

40



<Cut Mode>

Select cut mode of paper

Check Standard Cut
No check Synchronized Cut
<Mirror>

Setting of mirror
<Negative Image>
A mirror image can be printed
<Density>
Set Image Density
When input value is smaller, it shows lighter image, and vice versa.
1-9
<Image Shift>
Set if Image is required to shift from the center.

When “Set” button is clicked, the following dialog is popped up.

Image Shift 3
X +
+
h
Offset
X | DIZI‘ mm ¥: | D|Z|‘ mm
| OK | | Cancel |

Image placement is selectable up-shown 9 location.
When fine adjustment of the location is necessary, put the value to move to Offset
Xand.
When X is set as a positive, it moves to right. (-500 to 500)
When X is set as a negative, it moves to left. (-500 to 500)
When Y is set as a positive, it moves to upper. (-500 to 500)

When Y is set as a negative, it moves to lower. (-500 to 500)

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[HPGL]

Output setting of HPGL file is done.
When “HP-GL” tab is clicked, following dialog is popped up.

(General ﬁ’ HPGL r Calcomp rOriginaI Size Compensation \

Pen Width Mode : ® Values in file ) User defined values RTL Raster Density : 1 DDE
Grayscale Mode : ® Values in file () User defined values Enahle Clippng
Pen M: nt
eh lianageme ["] Enable Pen Scale
pandiehens Sl [] Cut and feed by SP/SPO
Pen Mo. Pen Size Grayscale q

; TR T — ["] Enable L& Setting
2 0.25mmrm 100% 1= [] Enable MC Setting
3 0.28mm 100%
4 0.25mrm 100% || Enable RP Setting
] 0.25mm 100%
[ 0.25mm 100% Halftone Screening {Transparent)
7 0.28mm 100%
5 0 26mm T00%
] 0.25mm 100% |

e ]
Setting items
<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<RTL Raster Density>
Adjust the density of HPGL RTL Image.

However, it is effective only if RTL image data are multi-valued image.
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<Enable Clipping>
When this is checked, the value of HPGL PS command is taken as the size of
image.
When this is not checked, image size is taken from minimum to maximum of
image.

<Enable Pen Scale>
If you check “Pen Scale”, the pen width is also enlarged or reduced if output size
is enlarged or reduced.
If you do not check it, the pen width is same even if output size is enlarged or
reduced.

<Cut and feed by SP/SP0>
When this is checked, multi-files are outputted since SP/SPO command is
recognized as a boundary of multi-drawing if it is included in the file.

<Enable LA Setting>
If you check “Enable LA Setting”, line processing is fixed as below.
Line Ends: Round
Line Joins: Rounded Join

<Enable MC Setting>
If you check “Enable MC Setting”, MC1 is validated.

<Enable RP Setting>
This is not available.

<Halftone Screening>
This function is validated with “Enable MC Setting” on.

Can be specified among Screening 1 (fine) to Screening 5 (coarse).

Note: Select “Not Use” when you are satisfied with existing image.

Halftone Screening (Transparent)

Not Use |

Mot Use

Screening 1 (Finehy)
SCreening 2
Screening 3
Screening 4
Screening 5 {(Rough)

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Calcomp]

["General | HPGL | Calcomp | Original Size Compensation

Pen Width Mode : @ Walues in file ) User defined values Synchronization Setting
Grayscale Mode: @ Values in file  User defined values Auto Detection

Pen Management

Manage Pens SAVE
Fen Mo. Fen Size Grayscale

1 0.25mm 100% -
2 0.25mm 100% =]
3 0.28mm 100%
4 0.25mm 100%
] 0.25mm 100%
i 0.25mm 100%
7 0.28mm 100%
B 0.25mim 100% Step: 800 |stepsicm
4 0.25mm 100% |

Setting items
<Pen Width Mode>
<Grayscale Mode>
When “Values in file” is selected, the values of Pen Width and Grayscale specified
in the file are effective, respectively.
When “User defined values” is selected, the values of Pen Width and Grayscale
effect according to the following User setting, respectively.
e Pen Size
When “User defined values” is selected, a value of Pen Size specified by
User is effective.
e Grayscale
When “User defined values” is selected, a value of Grayscale specified by
User is effective.
<Pen Management>
e Read
Loads an acquired pen setting.
e Save
Saves the current pen setting.
<Synchronization Setting>
A preferable Synchronization can be specified by either Automatic Setting or
Manual Setting.
Check “Auto Detection” in normal use. You can manually configure “Double Sync”,
“Checksum?”, “Sync-Cha” and “End-Char”.
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<Step Setting>
The output size of image can be specified by setting of a step number.

Usually, set to 800 for Step Setting.

Note: If some of the above items are modified, click [Enter] button, and

register the configuration.
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[Original Size Compensation]

It is possible to specify the magnification of x-direction and y-direction independently for
each media.

The print size can be compensated caused by media expansion and contraction by this.

[ General | HPGL | Calcomp | Original Size Compensation |

Enable Original Size Compensation

Plain

Length 1005 % Width 1005 U
Yellum

Length 1 DDE % Width 100 %
Film

Length 1 DDE % Width 100 %

Setting items
It is possible to specify the magnification of x-direction and y-direction
independently for each media.
The print size can be compensated caused by media expansion and contraction by
this.
When “Enable Original Size Compensation” is checked, the magnification
compensation is effective for each media (Plain/Vellum/Film).
It is possible for each media to compensate the magnification of x-direction (Width) and
y-direction (Length) independently.
The compensation ranges are guaranteed between 90% and 110%. (0.01% step)

Note: If some of the above items are modified, click [Enter] button, and
register the configuration.
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3.1.6. Log

Check the account log or the system log.
e Setting Items
[Account Log]

Account Log | CopyL0g| Scan Log | System Log

Acuire
Target:
* Al " Specific Date
ooos e s
ooos e s
Diata Kind
+ Sumrnary " Log
+ per User
" per Group
" perJoh

Acguiring Methad :

& Display " Download Execute |
Delete

Summary
* Al " Delete before Specified Day.

l— l— l— Delete |

In this Account log setting, term of Account information that is registered on Account log is

indicated, and the volume. Delete the contents of Account log also.
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[Copy Log]

Account Log  CopyLog | Scan Log | Systern Log

Acuire
Target:
* Al " Specific Date

oo el
eoe e [z

Acguiring Methad :

& Display " Download Execute |
Delete

Summary
* Al " Delete before Specified Day.

l— l— l— Delete |

In Copy Log setting, a determined term for Copy Log to be saved is indicated. The Copy Log

can be deleted also.

The below are an example of Account Table for Copy Log.

Account Table

Perniod : not speciiied. (A1l logs)
Accomnt IIY | Media | Total (square min) | Roll 841 run | Roll 297 min

Plain 995949 1189 0

5555
Total TTse 995949 1189 0
Plain 1623402 1782 420

0001
Total TTze 1623402 1782 420
Plain 999108 1188 0

8959
Total Use 299105 11=8 0

“ID No. 9999” represents an ID having made copies with Job Account disabled.
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[Scan Log]

AccountL0g| CopyLog Scanblog | gyster Log

Acuire
Target:
* Al " Specific Date

ooos e s
ooos e s
Acguiring Methad :

& Display " Download Execute |

Summary
* Al " Delete before Specified Day.

l— l— l— Delete |

Delete

In Scan Log setting, a determined term for Scan Log to be saved is indicated. The Scan Log can

be deleted also.

The below are an example of Account Table for Scan Log.

Account Table

Period : not specified (Alllogs)

Account Total Origimal Width | Orginal Width | Onginal Width
I {square ron) 841 mmn 594 man 297 mn
5555 995644 592 238 0
0001 1618009 1777 0 416
9999 1115096 0 1676 416

“ID No. 9999” represents an ID having made scans with Job Account disabled.
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[System Log]

Select any of the latest 8 kinds of system log on “Generation Number”.
Click Download to down load the selected system log.
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3.1.7. User

e Setting Items

[Password]

Password can be changed on [Password].
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[User Admin]

Passwarg  User Admin |

User

User | Full Name ‘ Group Description Mazimum IJPrinted Shé Time Restr%_
administrator Unlimited 5 Unlimited | Add User |

Group
Group Description Maximum Pr{ Printed Sheﬂ Time Remrid_
= Add Group |
<Add User>

Create a new user account. Click on "Add User" to display this dialog box.

User Name can contain up to 20 uppercase or lowercase characters except for the
following:

I\[]:;]=,+*?<>A user name cannot consist solely of periods ( . ) and

spaces. (50 user maximum)

User Management gl

New User:

User Mame: |

Full Mame:

Cescription:

|

Group Mame: | =1
|
|

Password:

[ Lirnit Max Sheet
Printed Sheets : mm |

[ Tirne Restrictions

Jo:00 =]
Jo:00 =]

Enter | Cancel

Java Applet Window
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<Properties>

Display the properties of a selected user account.

User Management E

User's Property

User Marne: |administ rator

Full Mame: |

Group Name: | =l

Description: |

FPassword: |*?H*H€**H€*?HH€*?HH€*

[ Lirnit Max Sheet nalik)
Printed Shests ;|5 mrm Clear |

[ Tirme Restrictions

Start Tirne
End Time:

Enter | Cancel

Java Applet Window

<Delete>

Delete the selected user account.
* administrator cannot be deleted.
<Add Group>

Create a new Group account. Click on "Add Group" to display this dialog box.

Group Management X]
New Group:
Group Mame: |
Description: |
[ Limit Max Sheet [ mrm | =l

Printed Sheets : mrn Clear; |

[ Time Restrictions

Start Tirme::
End Time :
Enter I Cancel

Java Applet Window
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<Properties>

Display the properties of a selected Group.

X

Group Management

Group's Property

Group Mame:  [asa

Description: |

[ Limit Max Sheet | mrs | =l

Printed Sheets . |10 mn Clear |

[ Time Restrictions
Start Tirme::
End Time :

Enter | cancel |

Jawva Applet Window

<Delete>

Delete the selected Group.
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3.1.8. System

Modify all the functions related to system management of Print Server in this system
dialog. Only the administrator can modify.
e Setting Items
[Server Control]

Server Control | SpoolerContr0I| Server Setting | Job Accounting Setting | License | Systern information

Rehoot | Restartthe Server.

<Reboot>
Reboot Print Server through browser. If it is done from

Client, it is necessary to finalize the browser of client.
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[Spooler Control]

Server Control  Siooler Control | Server Setting | Job Accounting Sefting | License | System information

Manage of printed jobs | Management of printed johs.

Empty Spoaler | Delete all johs inthe spooler.

| When paper empty,

Spooler Settin
P g reprint after waiting time prograss.

<Manage of printed jobs>
Automatically delete the jobs when the number of jobs in 'Printed

Queue' has exceeded the specified number.

Manaege of printed jobs El

Elimination by the number 10

Ol Cancel |

Java Applet Window

<Empty Spooler>

Remove all the data of queue that was spooled on Print Server Spooler.
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<Spooler Setting>
When “Load Paper” starts, it is spooled to the last queue of print waiting,

after a certain period later. (It becomes halt as it is, normally.)

Spooler Setting ﬁl

v 'When paper empty, reprint after waiting time progress.

waiting time |30 SEC.

Ok CAMCEL |

Java Applet Window

[Server Setting]

ServerControI| Spooler Control  Server Setting | Job Accounting Sefting | License | System information

| Match date and time of Server

Day and Time X . .
with setting of Client.

Metwork Setting | Metwork setting of server.

<Day and Time>

Match Server’s time and date with client’s.
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<Network Setting>
Set server's network configuration
Controller name:
Use DHCP server:
IP address:

Subnet mask:

Gateway:
DNS server:
Network &
Controller name:; |Kb-3E 50w
[~ Use DHCP server
IP address: 192|168 100 (10
Subnet mask: 255 |25h  |28R |0
Gateway: . ) )
DME server: . . .
0]14 Cancel Set default
Java Applet Window
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[Job Accounting Setting]

ServerControI| SpoolerContr0I| Server Setting  Job Accounting Setting | License| Systerm informati0n|

Job Accounting

Account 1D Account Name J Add account |

I Enter password to login.

The listed account IDs will be used with [Job Accounting] enabled under Menu Setting on the

printer’s Operation Panel.

<Add account>
Creates a new account.
An Account ID consists of 4 digits including from 0001 to 9998. The number of
Account ID can be registered up to 500.
Set a password to the new Account ID in 4 digits.
The password of a new Account ID that has not given any password will automatically

set in blank.

Add account le

Account 1D

Account Mame ;

Il

Password

[0]34 Cancel

Java Applet Window
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<Properties>

Changes information of the selected Account ID

<Delete>
Deletes the selected Account ID.
This can only delete the ID but not its log. If the same ID is created in the future

registration, the system will show the following message whether to delete the log.

Message PS_<|

Thiz ID number has ever heen used previously.
Do wou want to delete previous log information?

Yes I}

Java Applet Windaw

<Enter password to login>

Requires a password entry at Login on the printer’s Operation Panel.
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[License]

License ltem
KM-4800w

Option License items
Scan System 2

(Option license for “Scan to File”)
PDF

(Option License for PDF direct print such as Print Client KM)

61



[System Information]

<Version>

Displays the controller version
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3.1.9. Scan

This chapter explains how to download the scan image files to client PC.
e Setting Items
[Get Scan File]

| Get Scan File || Folder Setting || Scan to FTP |

Folder Name :

BOX 1 Docurment Page Size Submit Tirme

BOX 2

BOX 3

BOX 4

BOX 5

BOX 6

Specify a folder where desired scan image files are located in.
Between BOX 1 to 6 correspond to Scan Folder 1 to 6 in Operation Panel.
BOX 1: Scan Folder 1
BOX 2: Scan Folder 2
BOX 3: Scan Folder 3
BOX 4: Scan Folder 4
BOX 5: Scan Folder 5
BOX 6: Scan Folder 6
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To open any Scan Folder requires a password.

Enter it in the window shown below.
(Default P/W:0000)

Input Password

X

Folder Name : Scan Folder 1
Password : [
(4 digit numbers)
0K ‘ ‘ Cancel |

Java Applet Window

Scan image files are listed.

| Get Scan File || Folder Setting ||

Scan to FTP

Folder Name : Scan Folder 1

BOX 1 Document | Page

Size

Submit Time

SOOB0328_000052 11 |1

|1.3(m8)

|DB/D3r28 11:53.18

BOX 2

BOX 3

BOX 4

BOX 5

BOX 6

Select a file, Click Download File.
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Click Save if the window shown below appears.

File Download |

Same files can harm your computer. If the file information below
lonks suzpicious, or you do not fully tust the source, do not open or
zave this file.

File name: SDOB0Z23 000075 kf
File type:  TIF Image D ocument
Frarm: 172.20.51.58

Wwhiould you like to open the file ar save it to vour computer?

Open |

¥ &lways ask before opening this bpe of file

Cancel Mare Info

The file name and destination can be changed at your option.

Two or more files can be selected at a time.
In this case the files will be packed together and compressed as a zip file.

Scan image files are stored in KM-4800w for 72 hours, and are subsequently deleted.
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[Folder Setting]

| Get Scan File || || Scan to FTP
BOX 1
Folder Name : ‘Scan Folder 1
BOX 2
Input Password when browse ScanFolder
BOX 3 [] Input Password when Scanning
BOX 4 ‘ Config Password
BOX 5
BOX 6
Enter | | Cancel

Each Scan Folder's name can be changed at your option.

Maximum number of letters available for Scan Folder’s name is 16.

<Input Password when browse Scan Folder>

Requires a password entry to open the concerning Scan Folder.

<Input Password when Scanning>
Requires a password entry to save a scan data to the concerning Scan Folder.

An operator should enter a password on Operation Panel.

Click “Config Password” to change the password.

Note: Click “Enter” to validate setting changes.
The changes will not be saved without “Enter”
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[Scan to FTP]

| Get Scan File || Folder Setting ||
FTP Hame : FTP -1 {12 characters max.)
BOX 7
[] Input Password when Scanning | Config Password |
BOM 2 FIP Setting
® FIP Address 7z o [s |lss ]

1 FTP Server Name

Sending Path : [sauta |
Remote Port : 21
[ Passive Mode
Login Setting
Ainomymous Login
Enter | | Cancel

Specify the destination for Scan to FTP.

BUTTON 7 and 8 correspond to FTP 1 and 2 in FTP Folders' names.
Each FTP Folder's name can be changed at your option.

Maximum number of letters available for FTP Folder’s name is 12.

<Input Password when Scanning>
Requires a password entry to save a scan data to the concerning Scan Folder.

An operator should enter a password on Operation Panel.

Click “Config Password” to change the password.

<Sending Path>
When set the sending path destination to a subdirectory, describe the path with slash (/) as a
path separator.

ex) /scanfile/technical/service/

Note: Click “Enter” to validate setting changes.
The changes will not be saved without “Enter”
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4. Appendix



4.1. Trouble Shooting

4.1.1. Before conclude to malfunctioned

® Read Users Manual, confirm if the contents of obstacle is the limited item.
® Select the closest phenomenon from the following items, and confirm if the operation is

correct.

4.1.2. Output is not done from the Plotter.

Major causes of no output from the Plotter are:
® Print Server is not started up.

Remote Web Manager is not started up.

® Network between Print Server and Client is physically down.
® Network between Print Server and Client is logically down.
® Output configuration of Client machine is not set properly.

As shown above. Check the following items.

(1) Perform the test print through Print Server. Confirm if Printer is ready to print in this case.
If test print is done properly, confirm if Print Server and Printer is connected properly.

(2) Check if network cable is connected properly. If output was done without any problem
previously, there is a possibility that network connection between Print Server and client
has a problem. Confirm that network is physically correct at first. Check if cables around
hub and network support are connected properly, and check the power source of them.

(3) Check if network service is proper. If those are connected properly, there is a possibility
that network service is not done properly. Check used protocol (such as TCP/IP or Apple
Talk), or network setting of Print Server. Confirm that plotter and client are connected
properly to network using such as PING through Print Server. If they are correct, check if
Print Server and connected printer are possible to watch from Client. After this, check if
output is possible or not from the other client.

(4) Check if printer driver is installed properly. If not, printer driver is not set properly. Confirm
individual client following the setting of users manual, if the setting is properly done.

(5) In case there are two or more printers, confirm if Print Server is set at as an ordinary use

printer from the client side, or Print Server is not set to use.

4.1.3. Remote Web Manager does not start up

The causes that Remote Web Manager does not start up is:

® Print Server is not started up
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Network between Print Server and client is physically down.
Network between Print Server and client is logically down.

Network configuration of Print Server is not properly set.

Network configuration of client machine is not properly set.

As shown above. Check the following items.

(1) Check if network cable is connected properly. Confirm if network is physically correct.
Check if cables around hub and network support are connected properly, and check the
power source of them.

(2) Check if network service is proper. If those are connected properly, there is a possibility
that network service is not done properly. Remote Web Manager is working on the web
browser that is used TCP/IP protocol. Confirm to the network manager if TCP/IP of client
machine is properly set, such as installation of TCP/IP service, IP address of client
machine, gateway or masking of sub-net.

(3) Confirm if Web browser is used at Internet Explorer 6.0 SP1.

Remote Web Manager is confirmed its operation using Internet Explorer version 6.0 SP1
or later. When other browser than this is used, there is a possibility that indication is not

indicated properly.
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